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 1. Introduction 

 Everything  you  need  to  create  spatial  audio  is  now  integrated  with  Pro  Tools.  Immerse 
 Spatial  Audio  Production  Suite  is  a  unified  virtual  workflow  for  Surround  Sound  and  Atmos 
 mixing  for  Film,  Television,  Music,  and  Gaming.  Powered  by  the  Immerse  AI  Engine  and 
 designed  for  an  intuitive  user  experience,  this  production  suite  offers  industry  veterans  and 
 newcomers alike a better, faster, and easier way to mix their next immersive masterpiece. 

 Immerse  Spatial  Audio  Production  Suite  includes  three  products:  Immerse  Panner,  Immerse 
 Visualizer,  and  Immerse  Virtual  Studio.  Designed  exclusively  for  the  Avid  Pro  Tools  user,  the 
 suite  includes  AAX  plugins  and  a  Standalone  version  of  Immerse  Virtual  Studio,  as  well  as 
 the Immerse Audio Bridge for systemwide multichannel routing. 

 Immerse Panner 
 Immerse  Panner  allows  you  to  mix  mono  or  stereo  sound  sources  to  a  variety  of 
 multichannel  formats  within  an  intuitive  3D  interface.  Create  a  more  accurate  spatial 
 mix  by  placing  sound  objects  inside  a  visual  representation  of  your  spatial  sound 
 field. 

 Immerse Visualizer 
 Immerse  Visualizer  allows  you  to  see  the  placement,  volume,  and  dispersion  of  all 
 your  sound  objects  together  in  one  3D  space.  Streamline  your  spatial  mix  with  a 
 comprehensive  all-in-one  view,  and  make  quick  adjustments  without  having  to 
 access multiple windows. 

 Immerse Virtual Studio 
 AI  Personalization,  Room  Virtualization,  and  Headphone  Equalization  combine  to 
 make  Immerse  Virtual  Studio  the  most  accurate  spatial  monitoring  solution  for 
 headphones.  Gain  access  to  a  comprehensive  library  of  virtualized  world-class 
 studios  from  industry  legends  in  Film,  Music,  and  Gaming.  Turn  your  living  room, 
 bedroom,  car,  or  wherever,  into  a  professionally  treated  acoustic  space.  Mix  Atmos 
 on headphones from anywhere. 

 Immerse Virtual Studio Standalone + Immerse Audio Bridge 
 For  ultimate  flexibility,  monitor  your  Dolby  Atmos  mix  with  the  external  Dolby 
 Renderer, or any other external multi channel renderer. 

 This  manual  is  all  the  information  you  will  need  to  get  started  with  Immerse  Spatial  Audio 
 Production Suite. 
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 2. Quick Start Guide 

 Click here to watch the  Quick Start video 

 1.  Download  the  installer  from  Avid.com  member  portal  and  install  the  Spatial  Audio 
 Production Suite. 

 2.  Download the template or sample session and launch 

 3.  Activate  your  ilok  license  for  Spatial  Audio  Production  Suite  that  is  deposited  with 
 your Pro Tools subscription. 

 4.  Open  Immerse  Virtual  Studio  Avid  Plugin.  Login  with  your  email  address,  scan  the 
 QR code, submit your right ear image, and download your personalized hrtf profile. 

 5.  Select  your  favorite  studio  from  a  list  of  world  class  studios.  From  the  headphone 
 menu, select your favorite headphones. 

 6.  Open  Immerse  Panner  on  any  mono/stereo  track  to  adjust  individual  parameters  like 
 position of the object in the 3D space, and size of the object. 

 7.  Open  the  Immerse  Visualizer  for  a  master  view  of  the  placements  of  all  the  objects, 
 and sound dispersion. 
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 3. Getting Started 

 3.1 System Requirements 

 1.  Compatibility and Minimum System Requirements: 

 Software Format :  Plug-in and Standalone 
 Plug-in Types : AAX 
 Max Sample Rate : 192 kHz 

 Compatibility : 
 Win OS : Windows 10 and 11 
 Mac OS L 10.9.x and above 
 Mac M1, Mac M1 Pro, M1 Max, M2 

 Minimum System Requirements : 
 Processor : Intel Core 2 Duo 
 Memory : 4GB 
 Disk Space : 650MB 

 3.2 Installation 

 1.  Run  the  installer  ImmerseSpatialAudioProductionSuite-2.0.8.x.pkg.  The  installer  will 
 install  the  Immerse  Panner,  Immerse  Visualizer,  and  Immerse  Virtual  Studio  AAX 
 plugins  that  you  can  load  up  in  Pro  Tools,  as  well  as  the  Immerse  Audio  Bridge  and 
 Immerse Virtual Studio application for standalone mode. 
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 2.  Click on Next to proceed to install the plugins. 

 7 



 3.3 Uninstallation 

 1.  If  you  do  have  an  earlier  version  of  Immerse  Spatial  Audio  Production  Suite  installed, 
 we  recommend  you  to  uninstall  that  version  first  before  installing.  Click  on 
 “Customize,  select  “uninstall”,  and  click  on  “Install”.  After  uninstalling,  please  run  the 
 installer again. 
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 3.4 Creating a Pro Tools Session 

 1.  Open Pro Tools, Go to “File” -> Create New to open a new PT session 

 2.  Enter the name of your session, set the sample rate, Bit rate etc. and hit “Create”. 

 3.  Make  sure  the  hardware  and  Playback  Engine  is  set  correctly.  Select  your  Playback 
 Engine  as  your  desired  Sound  Card  for  headphone  output.  For  example,  in  the 
 graphic below, the output is set to External Headphones. 
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 Please  refer  to  the  table  below  for  supported  sample  rates.  The  filters  used  by  the  Immerse 
 Virtual  Studio  plugin  were  designed  for  all  commonly  used  sample  rates  (44.1  kHz  -  192 
 kHz), so no resampling happens no matter what sample rate you use. 

 Sample Rate (Hz)  Minimum H/W Buffer Size 

 44100  32 samples or higher 

 48000  32 samples or higher 

 88200  64 samples or higher 

 96000  64 samples or higher 

 176400  128 samples or higher 

 192000  128 samples or higher 
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 4.  Create  a  New  Track  in  Pro  Tools.  The  Immerse  Panner  can  be  inserted  either  on  a 
 mono or a stereo track. 
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 5.  With  the  Immerse  Panner,  you  can  pan  a  mono  or  stereo  track  to  a  5.1,  7.1,  or  7.1.2 
 Output. Create a multichannel Aux track (Immerse 7.1.2) as shown below : 

 6.  Ensure that the inputs and the outputs are set properly : 

 a.  Set  the  Mono  and  Stereo  track  output  to  your  multichannel  bus  or  Aux  Input. 
 In the following example, it is set to Immerse 7.1.2 Aux Input. 
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 b.  Insert  the  Immerse  Virtual  Studio  Avid  plugin  in  the  Immerse  7.1.2  Aux  track. 
 You  will  then  be  able  to  select  any  stereo  headphone  port  as  the  output  for 
 this track. 

 c.  Set output of Immerse 7.1.2 to the headphone output of the soundcard. 
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 3.5 Plugin organization in Pro Tools 

 1.  Searching for Plugins in Pro Tools can be customized. You can organize the Plug-in 
 menus by Category & Manufacturer. Go to  Pro Tools->  Setup -> Preferences  Organize 
 Plug-in Menus by : Category & Manufacturer 

 3.6 Loading Immerse Panner 

 1.  You  can  insert  the  Immerse  Panner  on  a  mono/stereo  track.  Find  the  Immerse 
 Panner  plugin  under  plug-in  ->  Embody  ->  Immerse  Panner  with  Avid.  Alternatively, 
 you can find the plugin under “Sound Field”. 
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 3.7 Loading Immerse Visualizer 

 1.  You  can  insert  the  Immerse  Visualizer  on  any  multi-channel  track,  typically  on  a  bus 
 which  receives  inputs  from  all  the  panners.  Find  the  Immerse  Panner  plugin  under 
 plug-in  ->  Embody  ->  Immerse  Visualizer  with  Avid.  Alternatively,  you  can  find  the 
 plugin under “Sound Field”. 
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 3.8 Loading Immerse Virtual Studio 
 1.  You  can  insert  the  Immerse  Virtual  Studio  on  any  multi-channel  track,  typically  on  a 

 bus  which  receives  inputs  from  all  the  panners.  Find  the  Immerse  Virtual  Studio 
 plugin  under  plug-in  ->  Embody  ->  Immerse  Virtual  Studio  with  Avid.  Alternatively, 
 you can find the plugin under “Sound Field”. 
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 3.9 iLok Activation 

 1.  When you insert any of the Immerse Panner, Visualizer, or Immerse Virtual Studio, 
 you will first need to activate your ilok license that is deposited with your ilok license. 

 2.  Click on “Activate” when the following ilok activation window appears. 

 3.  Enter your ilok.com user id and password and click on Next 
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 4.  Select the “Immerse Spatial Audio Production Suite” license and click on “Next” 

 5.  Select your ilok location where you want to put the license on. 
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 6.  On  successful  activation,  you  will  see  the  following  screen.  Click  on  “Continue”  to 
 start using the plugin. 

 3.10 Login Process 

 The login process for the Spatial Audio Production Suite is designed to be as seamless as 
 possible to access your personalized profile across devices and studios. The entire login 
 process is unified such that you can login first into any of the Panner, Visualizer, or Immerse 
 Virtual Studio. We recommend you to login using the Immerse Virtual Studio first. 

 1.  Open Immerse Virtual Studio Avid, you will first see the following onboarding page on 
 launch. Enter your email address, followed by the PIN. 
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 2.  You will then see a QR code. If you logged in through the panner first, you will not 
 need to login here in Immerse Virtual Studio. You will directly be redirected to the QR 
 code page. Scan the QR code to open a webpage on your phone. You can submit 
 the right ear image as per the guidelines given. Please click on “Watch Now” to learn 
 how to submit the image of the ear. Once you see the “Success” page on your 
 phone, click on “Done” in the plugin. 
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 3.  Click  on  “Get  Started”  to  open  the  main  UI  of  Immerse  Virtual  Studio.  You  will  be  first 
 presented with a quick tutorial. 
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 4.  Once  you  login  with  Immerse  Virtual  Studio  Avid,  you  do  not  need  to  login  in  Immerse 
 Panner  and  Visualizer  again.  Alternatively,  you  may  decide  to  login  with  Immerse 
 Panner  or  the  Visualizer  first.  Enter  your  email  address  and  click  on  Begin,  and  Enter 
 the Pin to continue. 
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 5.  Once  you  login,  you  will  see  the  main  UI  of  the  Immerse  Panner  as  shown  below. 
 You  will  be  automatically  logged  into  the  Immerse  Visualizer  and  Immerse  Virtual 
 Studio. 

 6.  You  can  also  login  first  from  the  Immerse  Visualizer.  Similar  to  the  Panner,  enter  your 
 email  address  followed  by  the  PIN  code  that  you  receive  in  your  email.  You  will  then 

 23 



 see  the  main  UI  of  the  Immerse  Visualizer  where  you  can  visualize  and  pan  all  the 
 objects from a single interface. 
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 Enjoy the Spatial Audio Production Suite! 
 All you need to create a truly immersive spatial audio 

 content in one place! 
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 4. Immerse Panner 

 MIX IN 3D 

 The  days  of  trying  to  place  3D  objects  using  a  flat  2D  interface  are  over.  Now  you  can  pan 
 mono  or  stereo  sound  sources  to  a  variety  of  multichannel  output  formats  within  an  intuitive 
 3D UI. Speed up your workflow, and get a clearer picture of your spatial mix. 
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 4.1 Moving the sound 

 1.  You  can  pan  by  first  clicking  the  puck  to  see  the  hand  icon,  and  then  moving  it 
 anywhere in the 3D space. 

 2.  You can also move the puck, by clicking any of the guidelines of the selected puck. 
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 3.  You can also adjust the X, Y, Z sliders to pan the pucks 

 4.2 Immerse Panner Control Panel 
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 1.  Output  Channel  Configuration  :  You  can  select  the  Panner’s  output  channels 
 configuration  from  this  drop-down  menu.  You  can  pan  a  mono/stereo  track  to  either 
 5.1, 7.1, or 7.1.2. 

 2.  Center  :  With  the  Center  Slider,  you  have  the  flexibility  to  control  how  much 
 contribution  goes  to  the  Center  channel.  When  Center  is  0%,  no  signal  will  go  to  the 
 Center channel. 

 3.  LFE  :  The  LFE  slider  controls  the  amount  of  LFE  content  you  want  in  the  LFE 
 channel.  When  LFE  is  100%  you  will  have  the  full  volume  of  your  signal  being  sent  to 
 the LFE channel. 

 Immerse  includes  an  LFE  Lowpass  Filter  which  is  on  by  default  at  120Hz  for  your 
 convenience,  to  ensure  you  are  not  sending  full  frequency  content  to  the  LFE.  You 
 can  set  the  cut-off  frequency  of  the  LFE  low-pass  filter  from  the  settings  panel,  or 
 completely bypass this feature. 
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 4.  Size  :  Adjusting  the  “Size”  modifies  the  diffusion  of  the  object  being  panned.  As  you 
 move  this  slider  up,  the  perceived  size  of  the  object  increases.  For  pinpoint  sound 
 location,  move  Size  smaller,  for  larger  sources  or  more  diffuse  localization,  increase 
 the  Size.  The  amount  of  diffusion  is  shown  as  a  glow  in  both  the  Panner  and 
 Visualizer. 

 5.  LR  Width  :  In  Stereo  Link  mode,  the  LR  width  changes  the  width  between  the  L  and 
 R  channels  of  a  stereo  track.  As  you  increase  LR  Width,  the  distance  between  L  and 
 R  pucks  increases.  Maximum  LR  width  corresponds  to  both  the  pucks  on  the  two 
 opposite walls 

 6.  Speakers  Tab  :  When  you  click  on  Speakers,  you  will  see  the  input  meters  for  all  the 
 output  channels  in  the  layout  you  have  selected.  You  can  adjust  gain  values  for  each 
 speaker  by  clicking  and  dragging  the  slider  values.  You  can  also  solo  each  speaker 
 by clicking “S”. 
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 7.  Objects  tab  :  Clicking  the  Objects  tab  opens  the  Object  view.  At  this  time,  we  are  not 
 referring  specifically  to  Dolby  Atmos  Objects,  but  you  can  consider  each  puck  to  be 
 its  own  Object.  Change  the  levels  for  each  Object  by  adjusting  the  slider.  You  can 
 edit  the  X,  Y,  Z  values  here  to  finely  adjust  the  precise  location.  In  addition  you  can 
 Solo  each  Object  independently,  unless  you  are  in  Stereo  Link  Mode.  Note  that  in 
 Stereo link mode, Solo will engage on both the Left and Right pucks together. 

 4.3 Adjusting the Views 

 1.  Back  :  Clicking  on  Back,  will  present  the  3D  space  from  the  perspective  of  standing 
 in  the  back  of  the  room  looking  towards  the  front.  The  left  front,  center,  and  right  front 
 speakers are in the farthest wall in the front. 
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 2.  Top  View  :  Clicking  on  “Top”  will  present  the  3D  space  as  if  you  are  in  the  ceiling 
 looking  down  on  the  room  This  view  can  be  useful  when  you  are  primarily  panning 
 front to back, without needing to visualize height in much detail. 

 3.  Click  and  drag  your  mouse  outside  the  puck  or  slider  areas  to  change  your  3D  view 
 angle.  When  your  mouse  is  outside  the  puck  or  slider  area,  you  will  notice  it  turns 
 into an arrow. 
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 4.  You  can  use  CMD  as  a  modifier  to  slow  down  the  movement  as  you  tilt  the  room.  And 
 the Scroll wheel will allow you to zoom in closer. 

 4.4 Link Stereo Pair 

 1.  Link Stereo Pair  : When the Immerse Panner is instantiated  on a stereo track, you 
 can either have the stereo pucks linked or unlinked while panning. In the linked 
 mode, as you pan, both the Left and the Right puck move together. In the unlinked 
 mode, you can pan both the left and right pucks independently as if they were two 
 completely different objects. 

 2.  Click on the toggle button to link/unlink stereo pair. 

 3.  In unlinked mode, each puck can be selected individually, and only one puck can be 
 selected at a time.  To select the other puck, simply click on it. 

 4.  In linked mode, you will see the sliders for both left and right pucks as you click on 
 any puck. In unlinked mode, only the slider for the selected puck is shown. 
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 4.5   Settings Tab 

 1.  Lock  Objects  to  Walls  :  The  movement  of  pucks  are  restricted  to  the  walls  only  when 
 “Lock  Objects  to  Walls”  is  On.  This  can  be  useful  if  you  only  want  to  pan  between  the 
 speakers  discreetly,  without  the  sensation  of  the  sound  diffusing  as  it  travels  through 
 the  middle  of  the  room.  By  default,  the  Panner  has  “Lock  Objects  to  Walls”  turned 
 off. 

 2.  Mirror  L/R  When  Stereo  Linked  :  When  Mirroring  is  On,  the  left  and  right  pucks  will 
 move  symmetrically  to  the  Y  axis,  or  the  horizontal  Left/Right  plane.  This  mode 
 requires the stereo link to be On. 
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 3.  Equal  heights  with  stereo  linked  :  As  you  pan  along  the  Z  plane,  or  height,  both  the 
 left/right  pucks  maintain  the  same  height  when  equal  height.  If  you  wish  to  pan  Left  and 
 Right  independently  including  height  turn  this  off  and  turn  off  Stereo  Link.  This  mode 
 requires the stereo link to be On. 

 4.  LFE  Low  Pass  Filter  :  The  LFE  low-pass  filter  is  a  courtesy  to  ensure  you  are  not 
 sending  a  full  frequency  band  to  the  LFE  channel.  The  slider  can  be  adjusted  to 
 change  the  low-pass  cutoff  frequency  of  the  LFE  send.  The  cutoff  frequency  can  be 
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 changed  from  20  Hz  to  1000  Hz.  Alternatively,  the  LFE  lowpass  filter  can  be  turned 
 Off, in which case there is no low-pass filter being applied. 
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 5. Immerse Visualizer 

 WHAT YOU SEE IS WHAT YOU HEAR 

 Nothing interrupts the creative process like overly complicated or convoluted workflows. 
 Immerse Visualizer acts like a master panner, allowing you to adjust the placement, volume, 
 and dispersion of all your sound objects together in one 3D space. Understand your 
 soundscape at a glance and streamline your workflow with this comprehensive all-in-one 
 view. 

 38 



 5.1 Selecting a sound 

 1.  All  Immerse  Panner  Objects  with  the  same  Output  Channel  Configuration  will  appear 
 here  and  can  be  moved  and  adjusted  directly  from  this  master  Visualizer  interface. 
 Don’t  see  any  panner  objects?  Please  create  a  stereo  or  mono  track,  insert  the 
 Immerse Panner, send it to the selected configuration, and return here! 

 2.  When  you  hover  over  a  certain  object,  the  hand  icon  is  displayed.  You  can  click  on 
 the  object  to  select  the  object  for  panning.  Note  that  for  a  stereo  puck,  both  the  left 
 and right pucks will be selected when stereo linking is On. 

 As  you  move  the  puck,  the  movement  is  restricted  by  the  setting  the  corresponding 
 panner  is  set  to.  For  example,  if  the  object  is  set  to  “mirror”  or  “Lock  objects  to  walls”, 
 that behavior will be reflected on this interface. 
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 5.2 Immerse Visualizer Controls 

 1.  Output  Channel  Configuration  :  The  output  channel  configuration  can  be  set  to  5.1, 
 7.1, and 7.1.2. 

 Please  ensure  your  Immerse  Panner  has  the  same  Output  Channel  Configuration  as 
 your  Visualizer.  When  the  visualizer  is  set  to  a  certain  configuration,  only  the  Immerse 
 Panner  objects  with  the  same  output  channel  configuration  are  displayed  in  the 
 Visualizer. 
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 2.  Show  Guidelines  :  Turn  On  “Show  Guidelines”  to  see  the  guidelines  associated  with  the 
 pucks.  Click  on  “Selected  Only”  to  display  only  the  guidelines  associated  with  the 
 selected pucks. Clicking on “All” will display all the guidelines of all the objects. 

 3.  Speakers  :  In  the  speakers  tab,  you  can  adjust  the  gain  values  for  each  speaker  output 
 channel  by  dragging  the  sliders.  You  can  also  Solo  each  speaker  by  clicking  on  the  Solo 
 button. 
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 4.  Objects  :  In  the  Objects  tab,  you  can  finely  tune  the  gains  and  X,Y,  Z  positions  for  each 
 of the objects that are panned to a certain output configuration. 

 5.  Solo  :  You  can  also  click  the  Solo  button  to  solo  each  of  the  objects.  Note  that  if  a  stereo 
 object  is  linked,  soloing  that  object  would  solo  both  the  left  and  the  right  objects.  The 
 Soloed objects are highlighted in the visualizer. 
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 6. Immerse Virtual Studio 

 TRUSTED VIRTUAL MONITORING 

 AI  Personalization,  Room  Virtualization,  and  Headphone  Equalization  combine  to  make 
 Immerse  Virtual  Studio  the  most  accurate  spatial  monitoring  solution  ever  created  for 
 headphones.  Gain  access  to  a  comprehensive  library  of  virtualized  world-class  studios  from 
 industry  legends  in  Film,  Music,  and  Gaming.  Turn  your  living  room,  bedroom,  car,  or 
 wherever,  into  a  professionally  treated  acoustic  space.  Mix  Atmos  on  headphones  from 
 anywhere. 
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 6.1 User Profile 

 1.  Click on the user icon  to display the user information  for all the users logged 
 into the plugin. 

 2.  User Profile  :  Click on “+” to add a new user. Clicking  on “-” will delete the 
 selected user. Note that this will delete all the user information including the HRTF. 
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 3.  Your username (email id) used for login will also be displayed in this menu. Click on 

 the  next to the email to see all the other information related to license, images 
 etc. 

 4.  License Type  : there is only one license type:” iLok  license” 
 Images Remaining  : A single user is allowed a total  of 5 different images. Number of 
 images remaining is displayed here. 

 5.  New Image  : Click here to submit a new image. You  will then scan the 
 QR code displayed to take a picture of your right ear. In future versions, you will be 
 able to audition and select the image that sounds good. 

 6.  Help  : Click on Help to open a detailed FAQ for this  product 
 Email Support  : If you have any questions, click on  “Email Support” to email our 
 support channels and we will get back to you very soon. All the information regarding 
 your license will automatically be populated. 
 Play Tutorial :  Click on “Play Tutorial” to play a  walkthrough tutorial. At any point of 
 time, if you want to skip, you can do so by clicking the “Skip” button. 

 7.  Click on the logo to open the product webpage. The product version is also displayed 
 here. 
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 6.2 Studio View 

 You can click on the speakers to Solo or Mute each of the speakers. Single click on each of 
 the speakers to Solo, Right click to Mute. You can also set the Exclusive or Latch behavior in 
 the Advanced Settings option. 

 6.3 Headphone EQ 

 1.  Click on headphones to open the headphone tab. You have a total of 36 headphones 
 to select from. Headphone EQ is necessary to maintain the true sound quality of the 
 original source. Select your favorite headphone preset from the headphone list. 

 2.  You can search for your favorite headphones with its name or any other key words. 

 3.  Click on the headphone brand to see the list of headphones available for that 
 particular brand. 
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 6.4 Studio Controls 

 1.  Channel Configuration  : Select the channel configuration  from a list of different 
 formats. As you select a particular format, only the studios compatible with the format 
 will be enabled, and others will be disabled. You can select from a wide variety of 
 surround options (5.1, 7.1, 7.1.2, 7.1.4, 7.1.6) and different configurations (SMPTE, 
 Film, ProTools). Please note that you can also modify any of these preset 
 configurations by modifying the speaker output configuration, in which case the 
 Channel Configuration will turn into “Custom”. When this happens, any studio can be 
 selected. 

 2.  Studio Menu  : Select from a list of world class studios  to virtually audition and mix 
 your favorite piece of multichannel/atmos music. With personalized HRTF, you will be 
 virtually transported to the sweet spot of the selected studio. 

 3.  Clicking  on  “S”  will  solo  the  Lower  speakers  by  default.  Click  on  “Upper”  or  “Lower”  to 
 solo the Upper or lower set of speakers. 
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 4.  Double  clicking  the  speaker  globes  will  Solo  the  corresponding  speaker.  Single  click 
 will  give  the  option  of  muting  or  soloing  the  respective  speaker.  Right  click  will  Mute 
 the speaker. Select the Exclusive or Latch behavior from the advanced settings. 

 5.  Ambience  :  Toggle  on/off  the  Ambience  to  turn  on  the  reverb  for  the  studio.  Adjust 
 the  ambience  value  to  control  the  amount  of  reflections  in  the  studio  as  per  your 
 taste. 

 6.  Master gain  :  Adjust the slider to control the output  master gain value. 

 7.  Inputs  : You can adjust the levels of each of the  speaker outputs from the Inputs tab. 
 Additionally, you can manually enter the gain values by editing the values under each 
 slider. 
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 By clicking on any of the output speakers (i.e. L, R, C), a dropdown menu will appear, 
 allowing you to select a different output speaker for that particular channel. Once an 
 output speaker is changed, the channel configuration is shown as “Custom” and is 
 saved. 

 8.  Headphones Tab  : You can turn on or off the Headphone  EQ in the headphones tab. 
 In addition, you can adjust the amount of headphone EQ to be added by adjusting 
 the slider. We recommend the user to set it around 60%. 

 6.5 Limiter 

 1.  You can turn on/off the Limiter by toggling the button next to “Limiter” 
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 2.  Input Gain  : You can set the input gain to the limiter  by adjusting this slider. 

 3.  Threshold  :  Threshold  determines  when  limiting  begins,  while  output  ceiling 
 specifies  how  much  limiting  is  applied.  When  the  threshold  is  low,  even  relatively 
 low-level  signals  will  undergo  gain  reduction,  while  a  high  threshold  will  yield  a  more 
 measured response. 

 4.  Release  :  The  release  control  determines  how  quickly  the  limiter  stops  working  after 
 the  signal  drops  below  the  threshold.  If  it  is  overly  long,  you  will  hear  audible 
 pumping, while if it is too short, distortion artifacts may result. 

 5.  Output  Ceiling  :  The  output  ceiling  is  the  limit  that  your  audio  signal  doesn't 
 cross  .  In  practice,  you  want  this  level  to  be  below  0  dBFS  to  prevent  any  digital 
 clipping.  Before  you  start  tweaking  any  settings,  I  recommend  that  you  set  the  output 
 gain limit to somewhere between -0.2 dBFS and -0.02 dBFS. 

 6.  Limiter  Overload  Protection  :  You  can  turn  on/off  the  overload  protection  by 
 toggling this button 

 7.  In  addition,  you  can  see  in  this  tab  when  the  limiter  is  engaged  or  not.  If  you  see 
 “Limiter Engaged”, it means that the limiter is engaged. 

 6.6 Advanced Settings 

 1.  HRTF  Intensity  :  Controlling  the  HRTF  intensity  adjusts  the  clarity  and  accuracy  of 
 localization  levels.  Higher  levels  of  HRTF  intensity  indicates  higher  accuracy  of 
 localization  but  medium  levels  of  sonical  clarity.  Lower  levels  of  HRTF  intensity 
 improves the clarity while reducing the localization accuracy a bit. 

 2.  Center  Balance  :  If  your  L/R  balance  seems  off,  adjust  this  slider  to  make  sure  the 
 Center is perceived right at the middle. 

 50 



 3.  LFE  lowpass  Filter  :  This  determines  the  LFE  low-pass  cutoff  frequency  that  is 
 applied  to  the  LFE  channel.  Note  that  this  value  is  different  for  different  studios  as  it  is 
 set to match the exact LFE characteristics of that particular studio. 

 4.  Speaker  Delays  :  Some  studios  manually  add  speaker  delays  to  each  of  the 
 speakers  to  match  the  acoustics  of  a  cinema  theater.  You  can  turn  on  the  Speaker 
 Delays  by  toggling  the  button  next  to  Speaker  Delays.  We  recommend  Speaker 
 Delays to be turned off especially when you are panning. 

 5.  Minimum  Phase  Response  :  Turning  this  On  means  the  HRIRs  being  applied  are 
 minimum  phase  response  in  its  nature.  The  perceptual  difference  between  turning 
 On and Off is often very subtle. 

 6.  Bypass  During  Offline  Bounce  to  Disk  :  Turning  this  On  will  bypass  the  plugin 
 when you are bouncing the audio in Pro Tools. 

 7.  Solo  Behavior  :  In  Latch  mode,  soloing  multiple  speakers  one  after  the  other  will  not 
 unsolo  the  previous  speaker.  In  Exclusive  mode,  only  one  speaker  can  be  soloed  at  a 
 time. 

 7. Standalone Application 

 7.1 Mac OS : 

 7.1.1 Setup Immerse Virtual Studio Standalone 

 1.  Go to Launchpad on MacOS, or Applications, and search for Immerse Virtual Studio 
 Avid. Alternatively, you can find Immerse Virtual Studio Avid in your Applications folder. 
 Click on the application to launch the Immerse Virtual Studio Standalone application. 
 This desktop application is a powerful tool where you can audition the output of the dolby 
 atmos renderer over headphones in some of the world’s finest studios with Immerse 
 Virtual Studio. 
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 2.  When you set Channel Configuration to a desired value, a list of studios which are 
 compatible with that specific channel configuration will be enabled and the rest of the 
 studios will be disabled (grayed-out). For example : 

 Channel Configuration 7.1.6 is supported by the following studios - Alan Meyerson Studio M, 
 Diamond Live Room, and The Anechoic Chamber. 

 3.  Setting up the Input/Output in the Immerse Virtual Studio Surround Standalone App 
 Click on “Options” on the top-left corner of the app -> Audio/MIDI Settings. 

 4.  Select the Input of the standalone app as “Immerse Audio Bridge”. Immerse Audio 
 Bridge is a virtual audio bridge designed by Embody to route audio to Immerse Virtual 
 Studio from various other applications such as the Dolby Atmos Renderer. Immerse 
 Audio Bridge is installed when you install the application (Step 1). 

 Immerse Virtual Studio is compatible with sample rates from 44.1kHz up to 192kHz. In 
 case you are using Dolby Renderer, you should select 48kHz since this is the sample 
 rate at which Dolby Renderer works. 

 Let’s select a Sample Rate of 48000 Hz, and Audio buffer size as 512 samples. 

 Make sure you select the correct Output device that routes to your headphones. 
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 In order to avoid any feedback, the audio input is muted by default. Make sure you 
 unmute it when you playback. 

 7.1.2 Setup Standalone Dolby Atmos Renderer 

 1.  Open the Standalone Dolby Atmos Renderer. Go to Preferences -> Driver. Set the 
 Audio Driver to Core Audio. Then set the Audio output device in the renderer to 
 “Immerse Audio Bridge”.  Click on Accept. 

 The Audio input device may be set to “Dolby Audio Bridge” if you are routing audio 
 from Pro Tools through the Dolby Audio Bridge. 

 Alternatively, if you decide to play the Atmos mastered files directly in the Dolby 
 Atmos Renderer, Audio Input Device does not need to be set to anything. 
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 2.  Setting up Dolby Atmos Renderer to your desired Speaker Layout output. For 
 example, for 7.1.2 setup 

 Go to Window -> Room Setup -> Monitoring. Add Monitoring layout, and Name it 
 7.1.2. Select setup. In this layout, the following channels are selected :  L, C, R, LFE, 
 Ls, Ltm, Rtm, Rs, Lrs, Rrs. 
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 In Routing -> assign the following routing (compatible upto 9.1.6) as shown below. I.e 
 L = 1, R = 2, C = 3, LFE = 4, Ls = 5, Rs = 6, Lrs = 7, Rrs = 8, Ltm = 9, Rtm = 10, Ltf = 
 11, Rtf = 12, Lw = 13, Rw = 14, Ltr = 15, Rtr = 16. 

 3.  Open an Atmos Master file.  Click on File -> Open Master  File 
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 4.  To play Atmos mastered files from the Dolby Atmos Renderer, Select Source as 
 “Master” 

 5.  You are now ready to experience 7.1.2 spatial audio in your favorite studio with your 
 personalized HRTF -- all on a pair of headphones! Click on the button to the left of 
 Stop and then Hit Play in the Dolby Atmos Renderer. 

 6.  Go to the Immerse Virtual Studio Avid Standalone application window. In the “Inputs” 
 tab, you can also control each of the 10 speaker input levels coming into the 
 Immerse Virtual Studio Avid Standalone application. 
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 7.2 Windows : 

 Unlike Mac Immerse Virtual Studio with Avid Standalone, the standalone version in windows 
 is an ASIO driver that takes in multichannel input from Pro Tools and binauralizes the output. 

 7.2.1 Setup Immerse Virtual Studio Standalone with Protools 

 1.  On ProTools, go to Setup -> Playback Engine, and select “Immerse Virtual Studio 
 (Avid)” 

 2.  Then, go to Setup -> Hardware, verify that Immerse Virtual Studio is the selected 
 Peripheral. You can then click on Launch Setup App, which shall open the Immerse 
 Virtual Studio with Avid Standalone User Interface. 

 3.  In Immerse Virtual Studio with Avid Standalone, open Options -> Audio/MIDI 
 Settings. 

 a.  Select Monitoring Source “Immerse Audio Bridge (ProTools.exe) 
 b.  Select Audio device type according to where you will be listening the mix on. 

 As an example: 
 i.  Audio device type: Windows Audio 
 ii.  Output: Headphones (Realtek ® Audio) 
 iii.  Input: None 

 c.  Select your sample Rate (default 48kHz should work fine) 
 d.  Audio buffer size : 512 is recommended for 44.1 and 48 kHz. For higher 

 sample rates, please select a buffer size of either 1024 or 2048 samples. 

 4.  In Protools, please ensure that the number of channels in the output is correctly set. 

 a.  Create a 7.1.2 bus named “Immerse 7.1.2”. Make sure that the output track to 
 be sent to the standalone is set to this 7.1.2 bus. 

 b.  Go to Protools-> Setup -> I/O, Output Tab, and create a new Path (i.e. 
 Immerse 7.1.2), which should have the number of channels needed (i.e. 5.1 
 will require 6 channels) 

 c.  In the I/O window, go now to Bus Tab. Scroll down until you see the Bus 
 Name “Immerse 7.1.2”. You should then enable the bus by ticking the empty 
 box, and then map it to the output path that you’ve created (in this example, 
 IAB7.1.2) 

 d.  Press OK, and now you should have routed the output track to the Immerse 
 7.1.2 bus which is mapped to your newly created IAB7.1.2 path 

 5.  You can now play your Pro Tools audio in the Immerse Standalone application! 
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 Now you can hear Atmos or Surround mixes on your 
 favorite pair of headphones as if you were 

 physically present in the Studio! 
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